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Using the Database Binding Component

The Database BC provides a comprehensive solution for configuring and connecting to
databases that support JDBC from within a JBI environment. In this tutorial, you will create a
SOA project using BPEL and the Database Binding Component, create a Composite
Application, and then deploy and test the application.

The topics listed here provides information about Understanding the Database Binding
Component (BC).

What You Need to Know

These topics provide information you need to know before using the Database Binding
Component.
■ “Tutorial Plan” on page 6.
■ “Database Binding Component Project in a Nutshell” on page 7.

What You Need to Do

These topics provide instructions to complete a Database Binding Component sample Project.
It also helps to test the Binding Component on the system and demonstrate how it is
implemented.
■ “To Start the GlassFish V2 Application Server From NetBeans IDE” on page 10.
■ “To Create a BPEL Module Project” on page 12.
■ “To Connect to a MySQL Database” on page 14.
■ “To Start the Admin Console” on page 18.
■ “To Integrate a JDBC Driver” on page 20.
■ “To Create a JDBC Connection Pool” on page 20.
■ “To Create a JDBC Resource” on page 23.
■ “To Create a WSDL Document : dbWSDL” on page 25.
■ “To Select the Database Connection” on page 27.
■ “To Edit the SQL Code” on page 30.
■ “To Create a WSDL Document : SOAPWSDL” on page 34.
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■ “To Create a BPEL Process” on page 42.
■ “To Add a Partner Link” on page 44.
■ “To Add a Web Service and Basic Activities” on page 45.
■ “To Edit Web Service : Receive1” on page 49.
■ “To Edit the Web Service : Invoke1” on page 51.
■ “To Edit the Web Service : Reply1” on page 55.
■ “To Edit the Basic Activities : Assign1” on page 57.
■ “To Edit the Basic Activities : Assign2” on page 59.
■ “To Invoke Explicit Validation” on page 61.
■ “To Create the Composite Application Project” on page 64.
■ “To Deploy the Composite Application” on page 72.
■ “To Test the Composite Application” on page 74.
■ “To Debug the Test Case” on page 79.

Tutorial Plan
Below is a summary of the steps that this tutorial takes you through to create a Composite
Application using the Database BC.

1. Create a BPEL Module project using the New Project wizard.

2. Create Database BC and SOAP BC WSDL documents for the BPEL Module.

3. Create a Composite Application project.

4. Add the BPEL Module project (*.jar) as a JBI Module to the Composite Application project.

5. Build the Composite Application project and make sure that the Application Server is
started.

6. Deploy the Composite Application project to the Application Server.

7. Create Test Case.

8. Run the Test Case.

9. (Optional) Debug the BPEL process.

This is performed when the Test Case fails.

Tutorial Plan
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Database Binding Component Project in a Nutshell
The illustration explains the entire process.

Flowchart 1

END

Deploy the
Composite Application project

to the Application Server

Create Test Case

Run Test Case Debug the
BPEL project

START

Create a BPEL Module
project

Create a Composite 
Application project

Add the BPEL Module as a
JBI Module

Make sure to start the
Application Server or

GlassFish V2

Build the Composite
Application project

Database Binding Component Project in a Nutshell
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Flowchart 1 (Continued)

Click New Project -> SOA ->
BPEL Module

START

Choose Concrete WSDL Document

Select Binding
Type; 
DATABASE

Select Binding
Type; 
SOAP

1. Click Service tab
2. Check for Database Connectivity

1. From the Right-hand panel,  click
    SOAPWSDL.wsdl editor tab or from the 
    Left-hand panel, double-click 
    SOAPWSDL.wsdl and click Bindings
2. Right-click and check the properties of input 
    (literal) and output (literal)
    Bindings of the created WSDL
3. Save the Project   

 Select Input and 
 Output Abstract
 Configuration

Tables
Prepared Statements
Procedures
SQL File

Select any one 
of the following 
Binding Subtypes:

1. Click Projects tab
2. Right-click Process Files -> New -> 
    WSDL Document or Right-click 
    BpelModule -> WSDL Document 

RPC Literal
Document Literal
RPC Encoded

Select any one of the 
following 
Binding Subtypes:

A

Database Binding Component Project in a Nutshell
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1. Drag and Drop the Input WSDL
    (SOAPWSDL.wsdl) to the left of the 
    BPEL panel and Output WSDL 
     (dbWSDL.wsdl) to the right of  
    the BPEL panel
2. Click Palette. Select the following:
a. Web Service - Receive:
    Basic Activities - Assign
b. Web Service - Invoke
   Basic Activities - Assign
c. Web Service - Reply
3. Edit each Web Service and Save All

Right-click Process Files -> New ->
BPEL Process

Start GlassFish V2 Server 
anytime before deplying
the project

Right-click and Build the BpelModule

Configure the Pool in Admin console

1. Expand Composit Appl -> Test -> 
    New TestCase1
2. Select BpelModule -> Process Files
a. SOAPWSDL.wsdl
b. SOAPWSDLPort
    (Binding=”SOAPWSDLBinding”) ->
    SOAPWSDLOperation
3. Click Input.xml tab -> delete existing
    value and enter a new value 
    (For example: 1)
4. Save the Project
5. Right-click TestCase1 -> Run

Right-click Composit Appl -> Deploy

1. Double-click the Process Mapper - 
    Receive. This displays the Mapper 
    tab.
2. Expand the Input and Output
    variables
3. Map the Input and Output variables
4. Save the Project 

1. Double-click Process Mapper - 
    Invoke. This displays the Mapper tab.
2. Expand the Input and Output
    variables
3. Map the Input and Output variables
4. Save the Project
 

1. Click Projects tab
2. New Project -> SOA -> Composite
   Appl -> Right-click -> Add JBI 
   Module -> Select BPEL Module
   -> Add Project JAR Files
3. Composit Appl -> Right-click Clean
    and Build
4. Save the Project

A

END

1. Double-click Process Mapper - 
    Reply. This displays the Mapper tab.
2. Expand the Input and Output
    variables
3. Map the Input and Output variables
4. Save the Project
 

Database Binding Component Project in a Nutshell
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Starting the GlassFish V2 Application Server
Follow the procedure to start the GlassFish V2 Application Server.

▼ To Start the GlassFish V2 Application Server From
NetBeans IDE

Choose Window —> Services, if the Services tab is not visible.

Click Services tab and expand the Servers node.

The Servers node should contain a GlassFish V2 subnode.

Right-click the GlassFish V2 node and select Start.

The Output window displays logging information about the application startup.

1

2

3

Starting the GlassFish V2 Application Server
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The following message appears in the Output console indicating the application server is
listening.
Application server startup complete

Note – A green arrow badge on the GlassFish Application Server node indicates the server is
listening.

Creating a BPEL Module Project For Table Type Operations
A table represents a database table. It consists of fields and methods. This allows you to perform
query, update, insert, and delete SQL operations in a table.

■ Fields correspond to the columns of a table
■ Methods are the operations that you can apply

Creating a BPEL Module Project For Table Type Operations
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Create a BPEL Module project with a name BpelModuleSample.

▼ To Create a BPEL Module Project
Choose File —> New Project from the main menu.

This opens the New Project wizard.

Select the SOA node from the Categories list.

Select the BPEL Module node from the Projects list.

Click Next.

In the Project Name field, enter BpelModuleSample.

1

2

3

4

5

Creating a BPEL Module Project For Table Type Operations
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Click Browse to navigate to the project location field.

The IDE stores the project files in this location. You can leave the default value.

Click Finish.

The Projects window now contains a project node for a BPEL Module project.

Click Save All.

6

7

8
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Connecting to a MySQL Database
Connections to databases are managed using database drivers, which enable applications
written in different programming languages to interact with the database management system.
Java CAPS include the MySQL Native (mysql-connector-java-5.1.5-bin.jar), which is a
Java implementation of the JDBC API, and communicates directly with the MySQL Driver.

▼ To Connect to a MySQL Database
Click Services tab.

Expand the Drivers node from the Database Explorer. Right-click the MySQL (Connector/J
driver) and select Connect Using.
The New Database Connection dialog box is displayed.

In the Basic Setting tab, enter the Database's URL in the corresponding text field.
The URL identifies the type and location of a database server. The format is
jdbc:mysql://hostname:port/database_name.

1

2

3

Connecting to a MySQL Database
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Enter User Name and Password.

Note – Select the Remember password option. This is optional.

4

Connecting to a MySQL Database
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Click OK to accept the credentials.

This displays a new Connection node in the Database Explorer under the Databases node.

Click OK to accept the default schema.

5

6

Connecting to a MySQL Database
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Right-click the MySQL Database URL in the Services window (Ctrl-5). Click Connect.

This opens the New Database Connection dialog box.
7

Connecting to a MySQL Database
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The illustration shows that the Database Connection is enabled.

You are now connected to the MySQL RDBMS in the IDE.

Starting the GlassFish Admin Console
You define the database connections for your project using the GlassFish Admin Console.

▼ To Start the Admin Console
Open a web browser and enter the following URL:
http://hostname:port/login.jsf

Note – The default port is 4848.

Enter the User Name and Password.

1

2

Starting the GlassFish Admin Console
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Note – The default username is admin; the password was specified during installation.

Click Login.

Setting Up Database Access
Follow these steps to create and configure a database connection:

1. Make the driver's JAR file accessible to the domain's server instance. See “To Integrate a
JDBC Driver” on page 20.

2. Create a connection pool for the database. See “To Create a JDBC Connection Pool” on
page 20.

3. Create a JDBC resource that points to the connection pool. See “To Create a JDBC
Resource” on page 23.

Integrating a JDBC Driver
A JDBC driver translates an application's JDBC calls into the protocol of the database server.

3

Setting Up Database Access
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▼ To Integrate a JDBC Driver

Make the driver accessible to the common class loader.

a. Copy the driver's JAR and ZIP files into the JavaCAPS_Home\appserver\lib.

b. Restart the application server.

Make the driver accessible to the system class loader.

Creating a JDBC Connection Pool
When creating the pool with the Admin Console, you are actually defining the aspects of a
connection to a specific database. A JDBC connection pool is a group of reusable connections
for a particular database. Because creating each new physical connection is time consuming, the
server maintains a pool of available connections to increase performance. When an application
requests a connection, it obtains one from the pool. When an application closes a connection,
the connection is returned to the pool.

Before creating the pool, you must first install and integrate the JDBC driver. See “To Integrate
a JDBC Driver” on page 20.

When creating the Create Connection Pools, certain data specific to the JDBC driver and the
database vendor must be specified. Before proceeding, gather the following information:

■ Database vendor name
■ Resource type (select one of the following options):

■ javax.sql.DataSource (local transactions only)
■ java.sql.ConnectionPoolDataSource (local transactions, possible performance

improvements)
■ javax.sql.XADataSource (global transactions)

■ Data source class name
■ Required properties, such as the database name (URL), user name, and password

▼ To Create a JDBC Connection Pool
Select the Common Tasks node, then click Resources —> JDBC —> Connection Pool.

Note – Select New to create a new connection pool from the New Connection Pool page.

1

2

1

Setting Up Database Access
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Specify the General Settings as follows:

a. Name: Specify a Name for the pool.

b. Resource Type: Select a Resource Type from the drop-down menu.

See the list of choices above.

c. Database Vendor: Select a vendor from the list provided in the drop-down menu.

Click Next.

Specify the additional General Settings as follows:

■ Datasource Classname: If the JDBC driver has a Datasource class for the resource type and
database vendor specified in the previous page, then the value of the Datasource Classname
field is provided. An example for MySQL is
com.mysql.jdbc.jdbc2.optional.MysqlDataSource.

■ Description: A text description of the connection pool.

2

3

4

Setting Up Database Access
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Specify the Pool Settings.

The values are entered, by default.

Specify the Connection Validation.

The values are entered, by default.

Specify the Transaction Isolation settings.

The values are entered, by default.

Add the required properties in the Additional Properties table, such as database name (URL),
user name, and password. Enter the following.

a. databaseName

b. password

c. portNumber

d. serverName

e. user

5

6

7

8

Setting Up Database Access
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Click Finish.

▼ To Create a JDBC Resource
Applications get a database connection from a connection pool by looking up a data source on
the Java Naming and Directory Interface (JNDI) tree and then request a connection. The
connection pool associated with the datasource provides the connection to the application.

Before creating a JDBC resource, first create a JDBC connection pool. See “To Create a JDBC
Connection Pool” on page 20.

Expand the Resources, then JDBC path node.

Select the JDBC Resources node.

Click New from the JDBC Resources page.

Specify the Resource settings as follows:

a. JNDI Name: Specify a unique name.
The JNDI name organizes and locates components within a distributed computing
environment similarly to the way that card catalogs organize and represent locations of
books in a library. Consequently, the JNDI name becomes an important method of
accessing the JDBC resource. By convention, the name begins with the jdbc/string.

9

Before You Begin

1

2

3

4
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For example: jdbc/payrolldb.

Note – Remember to give a forward slash.

b. Pool Name: Choose the connection pool to be associated with the new JDBC resource.

c. Description: Type a short description of the resource.

d. Status: If you want the resource to be unavailable, deselect the Enabled checkbox. By
default, the resource is available (enabled) as soon as it is created.

Click OK.

Creating a WSDL Document For Type : DATABASE
In this section, you add a WSDL document, to the BPEL Module project and then use the
Partner view of the WSDL editor to configure the components of the WSDL document.

5

Creating a WSDL Document For Type : DATABASE
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▼ To Create a WSDL Document : dbWSDL
Expand the project node in the Projects window.
The New WSDL Document wizard appears.

Right-click the project node or Process Files node. Select New —> WSDL Document.

In the File Name field, enter dbWSDL.wsdl.

Select Concrete WSDL Document.

■ binding
Defines the message format and protocol details for a port type. For JDBC Binding
Component, this is always a message containing a database operation defined using the
JDBC API.

■ service
Indicates which binding to use and how to access the database resource. For Database
Binding Component, the address element (<jdbc:address>) specifies the JNDI name for the
database resource.

In the Binding field, select Database from the drop-down list.

Choose any one of the following Types from the drop-down list.

■ Table
■ Prepared Statements
■ Procedures

1

2

3

4

5

6
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■ SQL File

Choose Type — Table from the drop-down list.

Click Next.

Select the URL from the drop-down list.

7

8

9
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You find the MySQL Database is not configured and is not available in the list.

Note – A broken icon indicates that the database is not connected.

▼ To Select the Database Connection
See “To Create a WSDL Document : dbWSDL” on page 25 to Create the WSDL Document.

Select the URL from the drop-down list.

Click Next.

Before You Begin

1

2
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Select the table from the DataSource and Table Objects.

Click the right arrow to move the table from Available Tables to Selected Tables.

Click the left arrow to remove the table from the list of Selected Tables.

Note – You can select and move one table at a time.

Click Next.

Select Operation Specific Attributes.

Click Advanced. Select the required Column name.

You can Insert, Update, Find, and Poll Records.

Note – As the ID is unique, they cannot be unchecked. Hence, these are greyed out.

3

4

5

6

7
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Note – Based on the requirement, you can check and deselect the Column names.

a. Choose Select All to select all the Column names.

b. Choose Clear All to clear all the Column names.

Click OK.

Click Next.

Enter an appropriate JNDI Resource Name.

Click Finish.

8

9

10

11
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Observe the following:

■ In the Projects window, the IDE adds a dbWSDL.wsdl node under the Process Files node
along with the .xsd file.

■ The dbWSDL.wsdl file is open in the WSDL editor.

The WSDL editor has three views: Source, WSDL, and Partner.
■ The Properties window is open.

Note – If you do not see the Properties window, choose Window —> Properties.

■ The Navigator window is open.

▼ To Edit the SQL Code
Double-click the created WSDL Document, dbWSDL.wsdl.

The WSDL Editor is opened.

Expand Bindings —> binding PortType=”jdbcPortype”.

For instance, you want to perform a find operation.

Select and expand find from the list.

Expand inputFind and click jdbc:input.

1

2

3

Creating a WSDL Document For Type : DATABASE
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Select sql from Properties.

Modify the SQL Statement.

Click the ellipsis.

The jdbc:input — sql Editor appears.

Make the necessary changes.

For example:
select PHONE, STATE, NAME, ZIP, ADDRESSLINE1, ADDRESSLINE2, CREDIT_LIMIT,

EMAIL, CUSTOMER_ID, CITY, FAX, DISCOUNT_CODE

from CUSTOMER where NAME=? and CUSTOMER_ID=?

Click OK.

4

5

6
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Click the paramOrder from Properties and enter the values.
For example, you want to find for NAME and CUSTOMER_ID. Enter the parameter order of
the result.

WSDL View
■ In the WSDL view of the WSDL Editor, the WSDL file appears as a tree component or a

series of columns.
■ The WSDL view has two subviews: tree view and column view. To switch between the

subviews, use the buttons in the WSDL Editor toolbar.
■ The main nodes in the WSDL view correspond to the major elements in a WSDL file.

■ Types: This node enables you to import XML schemas and to add inline schemas.
■ Imports: This node enables you to import WSDL files.
■ Messages: This node enables you to create, edit, and delete messages.
■ Port Types: This node enables you to create, edit, and delete port types.
■ Bindings: This node enables you to create, edit, and delete bindings.
■ Services: This node enables you to create, edit, and delete services.
■ Extensibility Elements: This node enables you to add the following extensibility

elements: partner link types, properties, and property aliases.

Some of the nodes in the WSDL view allow you to add extension attributes.
■ Right-click the node and choose Add Extension Attribute.
■ Specify the name and namespace in the Add Extension Attribute dialog box.
■ Specify the value from the Properties window after adding the attribute.
■ Right-click the node and choose Remove Attributes to delete the attribute.

7
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■ Right-click a node and choose Go To —> Source.

The Source view appears with the cursor positioned at the beginning of the component's block.

Source View
In the Source view, the underlying XML source code appears. You can directly edit the XML.

1. The top of the Source Editor has a tab for each open document. Each tab shows the name of
the document.

Note – If the document has been modified and has not been saved, then an asterisk (*)
appears after the name. You can right-click a tab to access various commands.

2. A toolbar is located at the top of the Source Editor window.

3. Source code displayed in the Source Editor is syntactically colored.

4. The Source Editor status line is located beneath the horizontal scroll bar. To toggle between
insert mode and overwrite mode, use the Insert key.

Creating a WSDL Document For Type : DATABASE
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Creating a WSDL Document For Type SOAP
In this section, you add a WSDL document to the BPEL Module project. Later, you can use the
Partner view of the WSDL editor to configure the components of the WSDL document.

When creating or editing a WSDL file, you may be prompted to select a binding type and a
binding subtype. A binding contains protocol and data format information for the operations
and messages of a port type. For more information, see step 6.

▼ To Create a WSDL Document : SOAPWSDL
Expand the project node in the Projects window.
The New WSDL Document wizard appears.

Right-click the node or Process Files node. Choose New —> WSDL Document.

1

2

Creating a WSDL Document For Type SOAP
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In the File Name field, enter SOAPWSDL.wsdl.

Select Concrete WSDL Document.

■ binding

Defines the message format and protocol details for a port type. For JDBC Binding
Component, this is always a message containing a database operation defined using the
JDBC API.

■ service

Indicates which binding to use and how to access the database resource. For Database
Binding Component, the address element (<jdbc:address>) specifies the JNDI name for the
database resource.

In the Binding field, select SOAP from the drop-down list.

The Binding — SOAP is selected and displayed, by default.

Select any one of the following Type.

If you select the SOAP binding type, then you must select any one of the following binding
subtypes:

■ RPC Literal: The operations are RPC oriented (that is, messages contain parameters and
return values). Each message part references a concrete schema definition by using the
element or type attribute.

■ Document Literal: The operations are document oriented (that is, messages contain one or
more documents). Each message part references a concrete schema definition by using the
element or type attribute.

■ RPC Encoded: The operations are RPC oriented (that is, messages contain parameters and
return values). Each message part references an abstract type by using the type attribute.

3

4

5

6

Creating a WSDL Document For Type SOAP

Using the Database Binding Component 35



Choose Type — RPC Literal from the drop-down list.

Click Next.

This action displays the New WSDL Document dialog box.

Choose the Operation Type from the drop-down list.

The WSDL Editor is used to create, edit, and delete port types.

The WSDL Editor supports the following categories of operations:

■ Request-Response Operation: The operation receives a message as input, and sends a
message as output.

■ One-Way Operation: The operation can either receive or send a message as input.

Each message contains one or more logical parts. Specify the name and the type of content for
each part.
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Tip – If you change the name of a port type or operation, then the WSDL Editor renames all
occurrences in the same file.

a. Right-click the component node to rename all occurrences in associated XSD, WSDL, and
BPEL files.

b. Choose Refactor —> Rename.

When Operation Type : One-Way Operation. The illustration is as shown.

Note –

a. Click the ellipsis to select any Element or Type.

b. Enter both the Input and Output Message Part Names for Request-Response Operation.

The default value of the Input and Output Message Part Names is xsd:string.

c. Click Add to another Message Part Name as the Input.

The checkbox Generate partnerlinktype automatically is selected, by default.
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Note – Click Remove to delete the Message Part Name as the Input.

See Steps 11 through 15.

Select Operation Type : Request-Response from the drop-down list.

Note – Port Type Name and Operation Name are populated from the previous wizard.

Click the ellipsis to select the Element or Type.

The Select Element or Type dialog box is displayed.

Expand By File.
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Select the Complex Types for both the Input and Output Message Part Name.

For example, CUSTOMER.
13
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Click OK.

The New WSDL Document is populated with the Input and Output Element Part Names.

Click Next.

Verify the Concrete Configuration.
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Click Finish.

Creating a BPEL Process
In this section, you add a BPEL process file, for example, BPELProcess.bpel. Add a partner link
and three activities to the BPEL process file.

16
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▼ To Create a BPEL Process
Expand the BPEL Module project node in the Projects window.

Right-click the BPEL Module project name or Process Files node. Choose New —> BPEL Process.

This opens the New BPEL Process wizard.

In the File Name field, enter BPELProcess.
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Click Finish.

Note –

■ In the Projects window, the IDE adds a BPELProcess.bpel node under the Process Files
node.

■ The BPELProcess.bpel file is open in the BPEL Designer.
■ The Properties window is open.
■ If you do not see the Properties window, choose Window —> Properties.
■ The Navigator window is open showing the BPEL Logical View of the BPEL Process

document.

4
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▼ To Add a Partner Link
Select the Partner Link from the Projects tab (for example, SOAPWSDL.wsdl).

This is the Input WSDL.

Drag and drop the SOAP WSDL Document to the left panel of the design area.

Select the Partner Link (dbWSDL.wsdl) from the Projects tab.

This is the Output WSDL.
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Drag and drop the database WSDL Document (dbWSDL.wsdl) to the right panel of the design
area.

▼ To Add a Web Service and Basic Activities
Drag and Drop the following Web Services:

■ Receive
■ Invoke
■ Reply

Drag and Drop the Basic Activities : Assign1 and Assign2.

Select the Web Service : Receive in the Web Service section of the Palette.

4
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Drag the selection to the BPELProcess box in the design area between the Process Start and the
Process End activities.

The IDE provides the visual clues to show an appropriate location to drop the selection.

This action places a Web Service Receive called Receive1 in the Design view.

Select the Basic Activities — Assign in the Basic Activities section of the Palette.

This action places a Assign activity called Assign1 in the Design view.

Drag the selection to the BPELProcess box in the design area, between the Process Start and the
Process End activities.

Note – Repeat steps 1 through 4 to select Invoke1, Assign2, and Reply1.

Choose the following:

■ Select the Web Service : Invoke and Basic Activities : Assign.
■ Select the Web Service ; Reply.
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Note – In the diagram, a red cross next to an element means that the element has not passed
validation and the output contains errors. Edit each Sequence to pass validation.
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The icon symbolizes that the Web Services can be edited.
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▼ To Edit Web Service : Receive1
Click Web Service — Receive1 and click Edit.

This opens the Receive1 [Receive] - Property Editor.

Select the properties from the Main tab. Select PartnerLink1 from the drop-down list.

The IDE fills in the Operation field with SOAPWSDLOperation.

Create a new input variable.

Perform the following:

■ Click the Create button next to the Input Variable field.

This opens the New Input Variable dialog box.
■ The Name, Type, and Scope are displayed, by default.

You can also change the value in the Name field.
■ Click OK.
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Note – All the fields are populated with the assigned values.

Input Variable — SOAPWSDLOperationIn

Click OK to close the Receive1 [Receive] - Property Editor.4
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Click Save All.

▼ To Edit the Web Service : Invoke1
Click Web Service — Invoke1 and click Edit.

This opens the Invoke1 [Invoke] - Property Editor.

Select the properties from the Main tab. Select PartnerLink2 from the drop-down list.

Select any one of the Operations from the drop-down list.

■ Insert
■ Update
■ Delete
■ Find
■ Pollrecords

5
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Select Operation — find from the drop-down list. The IDE fills in the Operation field.

Follow the steps to create a new input and an output variable.

a. Click the Create button next to the Input Variable field.

This opens the New Input Variable dialog box.

The Name, Type, and Scope are displayed, by default.

You can also change the value in the Name field.

b. Click OK to close the New Input Variable dialog box.

3
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c. Click the Create button next to the Output Variable field.

This opens the New Output Variable dialog box.

The Name, Type, and Scope are displayed, by default.

You can also change the value in the Name field.

d. Click OK to close the New Output Variable dialog box.

Note – All the fields are populated with the assigned values.

Select the following Variables:

■ Input Variable : FindIn
■ Output Variable : FindOut
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Click OK to close the Invoke1 [Invoke] - Property Editor.

Save the project.
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▼ To Edit the Web Service : Reply1
Click Web Service : Reply1. Click Edit.

This opens the Reply1 [Reply] - Property Editor.

Select the properties from the Main tab. Select PartnerLink1 from the drop-down list.

The IDE fills in the Operation field with SOAPWSDLOperation.

Follow the steps to create a New Output Variable.

a. Make sure to select the Normal Response radio button.
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b. Click the Create button next to the Output Variable field.

This opens the New Output Variable dialog box.

c. Change the value in the Name field. This is optional.

Reply1 is displayed, by default.

d. Click OK.
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Click OK to close the Reply1 [Reply] - Property Editor.

▼ To Edit the Basic Activities : Assign1
Double-click the Basic Activity : Assign1.

This displays the BPEL Mapper window.

Expand the node in the Source tree pane (the left pane) of the BPEL Mapper under Output —>
Variables (for example, SOAPWSDLOperationIn).

A part1 node appears under the SOAPWSDLOperationIn node.

Expand the node in the Destination tree pane (the right pane) of the BPEL Mapper under Input
—> Variables (for example, FindIn).

A part node appears under the FindIn node.

Select the node in the Source tree pane.

For example, SOAPWSDLOperationIn — part1 — CUSTOMER_Record.

Drag the selection and map it to the node in the Destination tree pane.

For example, FindIn — part — CUSTOMER_Record.

4
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Map the following Variables:

a. NAME — NAME

b. CUSTOMER_ID — CUSTOMER_ID

Click the Design tab.

Note – A red icon marked against Basic Activities — Assign1 is not shown.

6

Creating a BPEL Process

Oracle Java CAPS Database Binding Component Tutorial • March 201158



▼ To Edit the Basic Activities : Assign2
Double-click the Basic Activity : Assign2.
This displays the BPEL Mapper window.

Expand the node in the Source tree pane (the left pane) of the BPEL Mapper under Output —
Variables (for example, FindOut).

Expand the node in the Destination tree pane (the right pane) of the BPEL Mapper under Input
— Variables (for example, SOAPWSDLOpertionOut).

Select the node in the Source tree pane.
For example, FindOut : part : CUSTOMER_Record.

Drag the selection to the node in the Destination tree pane.
For example, SOAPWSDLOpertionOut : part1 : CUSTOMER_Record

Map the following variables:
■ PHONE : PHONE
■ STATE : STATE
■ NAME : NAME
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■ ZIP : ZIP
■ ADDRESSLINE1 — ADDRESSLINE1
■ ADDRESSLINE2 — ADDRESSLINE2
■ CREDIT_LIMIT — CREDIT_LIMIT
■ EMAIL — EMAIL
■ CUSTOMER_ID — CUSTOMER_ID
■ CITY — CITY
■ FAX — FAX
■ DISCOUNT_CODE — DISCOUNT_CODE

Finally, map part : part1.
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Click the Design tab.
The final output is as shown in the illustration.

Right-click the project node and select Clean and Build.
The following message is displayed.
BUILD SUCCESSFUL (total time: 2 seconds).

Click Save All.

Validating BPEL
The BPEL Designer has a built-in BPEL code validation functionality that helps create
well-formed, valid and standard-compliant code. The code is checked for errors and is notified
if validation fails.

▼ To Invoke Explicit Validation
To invoke explicit validation, perform any one of the following:

Right-click the source to invoke the pop-up menu in the Source view and choose Validate XML
(Alt-Shift-F9).
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Click the Validate XML button (Alt-Shift-F9) on the Editor toolbar in the Design view.

Design View : Notifications
The user is notified about validation errors or success in the Output window, in the Design
view, and in the Navigator.

The Design View
The Design view shows the results of both real-time and explicit validation in call-out windows
on the diagram and the error stripe.

In the illustration,

Note – A red cross next to an element on the diagram means that the element has not passed
validation and the output contains errors.

A yellow triangle with an exclamation mark means that the element has not passed validation
and the output contains warnings.

A red cross in the Design view means there are both errors and warnings.

If you click the cross or the triangle, a call-out window appears with a list of errors and/or
warnings.
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The call-out window includes messages related to validation in accordance with all the criteria
listed above. Messages related to the real-time validation are constantly updated.

In the Design view, validation results are also shown by the error stripe, which is a strip to the
right of the scroll bar that contains red marks if some elements have not passed validation. The
error stripe represents the entire diagram, not just the portion that is currently displayed. You
can immediately see if the BPEL process contains errors without having to scroll through the
entire diagram. You can click a red mark to jump to the element that causes problems. If no
errors are detected, the small square in the error stripe is green.
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Creating the Composite Application Project
Add the JBI module to the BPEL Module project before deploying the Composite Application.
Deploying the project makes the service assembly available to the application server, thus
allowing its service units to run.

▼ To Create the Composite Application Project
Choose File —> New Project from the main menu.

This opens the New Project wizard.

Select the SOA node from the Categories list.

Select the Composite Application node from the Projects list.
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Click Next.

In the Project Name field, enter DBBCSampleCompositeApp.
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Click Finish.

The Projects window now contains a project node for a Composite Application project called
DBBCSampleCompositeApp.

Right-click either the Composite Application Project node or expand the node and select JBI
Modules.
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Select Add JBI Module.8
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Select the BpelModuleSample Project. Click Add Project JAR Files.

The Project JAR Files is build/SEDeployment.jar.

The BpelModuleSample.jar file is added into the project.
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Click Save All.

A detailed illustration is as shown on the deployed JBI Components.

a. Expand IDE, open the Services window, expand the GlassFish V2 node, and expand the JBI
node.

b. Right-click sun-database-binding and click Start.
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Note – If you do not see the JBI node, you need to start the Application Server by choosing
Start from the pop-up menu of the GlassFish V2 node.
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Right-click the DBBCSampleCompositeApp Composite Application project node and select
Clean and Build.
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The CASA Editor displays the build of DBBCSampleCompositeApp.

A message is displayed in the Output window:
BUILD SUCCESSFUL (total time: 2 seconds)

Click Save All.

Deploying and Testing the Composite Application
In this section, you deploy the Composite Application project and then test the deployed
application. Start the GlassFish Application Server before deploying the project. See “Starting
the GlassFish V2 Application Server” on page 10.

▼ To Deploy the Composite Application
Troubleshooting

■ Stop the GlassFish V2 Application Server and Restart to ensure the connection.
■ Logout of the GlassFish Admin Console and Login.
■ Go to Resources —> JDBC —> Connection Pools —> Choose the defined Connection Pool.
■ Click the Connection Pool.

The Edit Connection Pool screen is displayed.
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■ Ping the Connection Pool.

The following confirmation message appears.

Ping Successful

Select the project node in the Projects window.

For example, DBBCSampleCompositeApp

Right-click and choose Deploy.
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After successful deployment of the project the following message appears in the Output
window:
BUILD SUCCESSFUL (total time: 18 seconds)

▼ To Test the Composite Application
Click Test.

Right-click and select New Test Case.

Enter the Test Case Name.

Click Next.

Select the WSDL Document.

a. Select the following:
For example, SOAPWSDL.wsdl from BpelModuleSample : Process Files.

Note – One WSDL document must be selected.

b. Click Next.
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c. Select the following:

SOAPWSDLOperation from SOAPWSDLPort (Binding=”SOAPWSDLBinding”)

Note – One operation to text must be selected.
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Click Finish.

The Source Code is as shown.

Enter the string values.

For example:

■ NAME — Nano Apple
■ CUSTOMER_ID — 3
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When you enter the string values in the Input.xml window, the output console displays
Retrieve.xml. This window displays the location to save the data.

Right-click the Test Case and click Run.

A confirmation box to overwrite the Output is displayed. Click Yes to overwrite.
8
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The Output is as shown in the illustration.

Debug the Test Case
You can debug the test case.
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▼ To Debug the Test Case

Right-click on the Test Case and select Debug.
A message is displayed as shown in the illustration.

For a demonstration, see
http://wiki.open-esb.java.net/Wiki.jsp?page=DatabaseBindingComponentFlightDetails.

Creating a BPEL Module Process Using Prepared Statements
A Prepared Statement represents a SQL statement that has been compiled. Prepared statements
can be used to perform insert, update, delete and query operations. Prepared statements
provide the ability to create queries that are more secure, have better performance, and are
more convenient to write. They come in two flavors: bound parameter prepared statements,
and bound result prepared statements.

Prepared statements allow query templates to be created and then stored on the database server.
When a query needs to be made, data to fill in the template is sent to the database server, and a
complete query is formed and then executed.

The basic process for creating and using bound parameter prepared statements is simple. A
query template is created and sent to the database server. The database server receives the query
template, validates it to ensure that it is well-formed, parses it to ensure that it is meaningful,
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and stores it in a special buffer. It then returns a special handle that can later be used to reference
the prepared statement. When a query needs to be made, data to fill in the template is sent to the
database server, and then a complete query is formed and then executed.

This process has some very important behaviors wrapped up in it. The body of the query is only
sent to the database server once. On requests to execute the query, only the data to fill in the
template needs to be delivered to the database server. Most of the work required to validate and
parse the query only needs to be done a single time, instead of each time that the query is
executed. Additionally, for queries that contain a small amount of data, the overhead of sending
the query is greatly reduced.

For steps, see the following links:

1. “Creating a WSDL Document For Type : DATABASE” on page 24

a. Select Type — Prepared Statement.

b. Enter a valid Prepared Statement.

c. Click Discover Parameters to view types for the parameters.

d. Click Discover Resultset to discover the Resultset types.
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e. Click Next.
f. Enter JNDI Name.
g. Click Finish.

2. “Creating a WSDL Document For Type SOAP” on page 34.
3. “Creating a BPEL Process” on page 41.
4. “Validating BPEL” on page 61.
5. “Design View : Notifications” on page 62.
6. “Creating the Composite Application Project” on page 64.
7. “Deploying and Testing the Composite Application” on page 72.

For a demonstration, see
http://wiki.open-esb.java.net/Wiki.jsp?page=DatabaseBindingComponentPollScenario.
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Creating a BPEL Module Project Using Procedures
A Procedure represents a database stored procedure. Fields correspond to the arguments of a
stored procedure while methods are the operations that you can apply. It allows you to execute a
stored procedure.

Note – Select a Procedure from the list and add the stored procedure to the Selected Stored
Procedures console.

For the procedure, see the following links:

1. “Creating a WSDL Document For Type : DATABASE” on page 24

a. Select Type — Procedures

b. Click Next.

c. Select the URL from the drop-down list.

d. Select a Stored Procedure and click Add to move the selected Stored Procedure to the
Selected Stored Procedure panel.
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e. Click Next.

f. Enter JNDI Name.

g. Click Finish.

2. “Creating a WSDL Document For Type SOAP” on page 34

3. “Creating a BPEL Process” on page 41.

4. “Validating BPEL” on page 61.

5. “Design View : Notifications” on page 62.

6. “Creating the Composite Application Project” on page 64.

7. “Deploying and Testing the Composite Application” on page 72.
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For a demonstration, see
http://wiki.open-esb.java.net/Wiki.jsp?page=DatabaseComponentStoredProcedure.

Creating a BPEL Module Project Using SQL File
This is the script that contains the data definition statements for the MySQL database. The file
filter for the file open dialog window defaults to *.sql so you should only be able to view files
with the .sql extension.

For procedure, see the following links:

1. “Creating a WSDL Document For Type : DATABASE” on page 24.
a. Create a .sql file using Notepad.
b. Save the file in a folder location.

c. Choose Type — SQL File.
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d. Click Browse to select the saved .sql file.
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The selected file is displayed as shown in the Figure.

e. Click Discover Parameters to view types for the parameters.
f. Click Discover Resultset to discover the Resultset types.
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g. Click Next.
h. Enter JNDI Name.
i. Click Finish.

2. “Creating a WSDL Document For Type SOAP” on page 34.
3. “Creating a BPEL Process” on page 41.
4. “Validating BPEL” on page 61.
5. “Design View : Notifications” on page 62.
6. “Creating the Composite Application Project” on page 64.
7. “Deploying and Testing the Composite Application” on page 72.

For a demonstration, see
http://wiki.open-esb.java.net/Wiki.jsp?page=BuildSampleProjectSQLFileDatabaseWSDL.
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